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MT+ 
 

How to export and import 
mobilities 
 

 

In this demo you will see how to export the template or the list of existing mobilities, an explanation 
of the format of the CSV file how to use the CSV file to update existing mobilities or add new 
mobilities, and how to import the CSV file. 
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This scenario is based on a KA103 project and the export and import for student mobilities. This may 
be different for other key actions and activities. 

 



 Monday, January 04, 2016 

 

Page 3 of 62 

Slide 2 - Slide 2 

 

Text Captions 
 

Go to the Mobilities menu item and select Import - Export. 
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On this screen, you can perform the export and import of student mobilities and of staff mobilities.  
 

Due to the fact that these two types of mobilities contain different fields, there are two separate 
functionalities which allow the import and export of these types of mobilities. 
 

In order to download the Mobility Tool+ Data Dictionary click on the button.  
 

Click on the Mobility Tool+ Data Dictionary button 
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In order to download the Mobility Tool+ Data Dictionary click on the button.  
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The export/import file uses dictionary codes which are unique abbreviations for the terms used in 
fields and dropdown lists. 
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Click on the Export Excel/CSV button 
 

Click on Export Excel/CSV for Student Mobilities and associated Organisations information. 
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Click on Export Excel/CSV for Student Mobilities and associated Organisations information. 
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Select to save the file as type CSV. Never open the file directly after export. 
 

Click the Save button 
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Click the Start button 
 

Go to Start. 
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Search for Excel. 
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Click to open Excel 
 

Click to open Excel.  
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Select the Data tab 
 

In Excel, go to the Data tab. Do not go to File to open the exported CSV file. 
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Click the From Text button 
 

Select the option to get data from external source, using the option From Text. 
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Select the CSV file 
 

Select to open the CSV file just exported. 
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Select the option Delimited. 
 

Select Delimited  
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Click the Next button 
 

Ensure that the File origin: is 65001 :  Unicode (UTF-8) 
 

Click on Next. 
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Select Semicolon 
 

Select the Delimiters as Semicolon. 
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Click the Next button 
 

The text qualifier as a " quotation mark. 
 

Click on Next. 
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Click the Advanced... button 
 

Click on Advanced and ensure that the Decimal separator is set as a point and the Thousands 
separator is set as a comma.  
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Click on Advanced and ensure that the Decimal separator is set as a point and the Thousands 
separator is set as a comma. 
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Click the OK button 
 

Click on OK. 
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In the Data preview, select all columns.  
 

Do this by selecting the first column, scrolling to the right and while holding down the shift key, 
select the last column. 
 

Select the first column 

 

 
 

Select the first column 
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Shift + select the last column 
 

Do this by selecting the first column, scrolling to the right and while holding down the shift key, 
select the last column. 
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Select the Text radio button 
 

Only select the Text radio button once all columns are selected. 
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Click the Finish button 
 

Click on Finish.  
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Click the OK button 
 

Select to Import Data to existing worksheet and click on OK. 
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In this example, there is already one mobility added. The first row details the names of the fields. 
 

The second row indicates if the field is mandatory, by the presence of an asterisk. It also indicates if 
a dictionary value is required or whether special formatting, such as the format for dates or decimal 
places, is required. 
 

Each mobility will be listed per row. 
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The first column shown is the Project ID. You can note that this is a mandatory field by the presence 
of an asterisk in the 2nd row. 
 

The second column, Activity Type, is also mandatory and must contain a valid dictionary value.  
 

In this case, it indicates HE-SMP-P for Student mobility for studies between Programme 
Countries. 
 

The Long-term activity column uses the dictionary value (YES/NO).  
 

Only YES or NO can be used in this cell to indicate if the mobility is a long term activity or not. 
 

The Participant ID column is neither mandatory and no dictionary value or special formatting is 
required. 
 

The next columns deal with the participant details, First Name, Last Name and Date of Birth. 
 

The Date of Birth field indicates that the value must be entered in the format DD-MM-YYYY. 



 Monday, January 04, 2016 

 

Page 30 of 62 

 

Let’s move on to the Mobility ID in column N. 
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This field is mandatory and must be unique for each mobility entered in the Excel file and for the 
project.  
 

Changing the Mobility ID slightly, for example replacing the dash with a dot, will create a new 
mobility.  
 

Changing all other details of the mobility: participant's name, address, etc., but keeping the Mobility 
ID the same, will overwrite all previous details for that Mobility.  
 

The Field of Education in column Q, is mandatory, and only accepts the dictionary value.  
 

These values can be found in the Mobility Tool+ Data Dictionary. 
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All organisations that have been created in MT+ will have an Organisation ID.  
 

If the Organisation ID is not changed or updated in the project in MT+, then the system will 
automatically generate the Organisation ID.  
 

It will be composed of the Project ID, the letters ORG and a sequential number. The Organisation ID 
must be unique for each organisation in the project.   
 

The Organisation ID is linked with both the Erasmus Code and the PIC.   
 

When the Organisation ID, and either the PIC or Erasmus Code are entered, the organisation's 
remaining details are not required to be completed  
 

in the Import file. This is true for both the sending and receiving organisations details. 
 

Let’s skip to column CK. 
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The Start Date of the mobility must have the format DD-MM-YYYY, using a dash as separator. 
 

Finally let’s look at how the mobility grant amounts are entered.  
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The Monthly Grant in column CP is entered. The full stop must be used as the decimal separator. 
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Select the entire row of the mobility 
 

In order to explain how to add new mobilities, we will look at a simple scenario where 5 new 
mobilities are added.  
 

Each mobility will have a different participant coming from the same organisation and going to the 
same location.  
 

The mobility budget is also the same for each mobility. 
 

Copy the existing mobility from line 3 of the Excel file. 
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Press Ctrl + C (copy) 
 

Copy the existing mobility from line 3 of the Excel file. 
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Copy the existing mobility from line 3 of the Excel file. 
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Select the rows and press Ctrl + V (Paste) 
 

Paste into the 5 next rows. 
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Paste into the 5 next rows. 
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Now the 6 rows contain the same information for one mobility.  
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Before completing the details for each participant, update the participant ID with a unique ID or 
leave blank. 
 

The Project ID must be the same for all rows in the CSV file. 
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The following cells in each row, must be updated with 5 different participant details and a unique 
Mobility ID. 
 

Change the names and other personal information of the participants. 
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Don't forget to provide a unique Mobility ID for each row. This must be unique for the project.  
 

You can not have two the same in the excel file or it will error on upload.  

 

  

 



 Monday, January 04, 2016 

 

Page 44 of 62 

Slide 51 - Slide 51 

 

Text Captions 
 

If the Mobility ID is the same as an existing Mobility ID, it will overwrite the existing mobility.  
 

Any new Mobility ID added to the excel file will result in a new mobility added to the project. 
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Click the File Tab 
 

Save the file. 
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Save the file. 
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Make sure to save the file as type CSV (Comma delimited) (*.csv).  
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Make sure to save the file as type CSV (Comma delimited) (*.csv).  

 



 Monday, January 04, 2016 

 

Page 49 of 62 

Slide 56 - Slide 56 

 

Text Captions 
 

Select Tools 
 

Ensure that the web option Unicode - (UTF-8) encoding is set.  
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Select Web Options...  
 

Ensure that the web option Unicode - (UTF-8) encoding is set.  
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Select the Encoding tab 
 

Ensure that the web option Unicode - (UTF-8) encoding is set.  
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Please note, that even though UTF-8 is selected, MS Excel will not save the characters correctly for 
most of the 27 alphabets used by National Agencies and participant of the Erasmus+ programme. 
 

In this case use an alternative tool such as LibreOffice Calc, Apache Open Office Calc or iworks 
Numbers.  
 

More details are explained in the video tutorial: How to work with CSV.  
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Click the Save button 
 

Click on Save. 
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Click the Yes button 
 

Click YES. 
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Return to the Import - Export mobilities screen of your project. 
 

Now you are ready to import the list of Student Mobilities and the associated Organisation 
information. 
 

Remember there is a separate template for staff mobilities. It is not possible to import the two types 
of mobilities together. 
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Click on Import  
 

Click on Import and select the file. 
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Click on Import and select the file. 
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Scroll down to the import history section. 
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Click on Refresh, to update the import history information. A successful message is displayed. 
 

Click the Refresh icon 
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Go to the Mobilities dropdown list and select List Mobilities.  
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You will see that the mobilities have been added to the project. 

 



 Monday, January 04, 2016 

 

Page 62 of 62 

Slide 69 - Slide 69 

 

Text Captions 
 

End of this demo 
 

 

 

 


